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INCREASING DYNAMIC RANGE 

Where a scene contains a very great range of brightness, sacrificing the shadows may be 

one option, but it isn't the only one. If the camera is mounted on a tripod, another approach 

is to take a matching pair of images and marry them later in Photoshop. 

EXPOSING TO THE RIGHT 

"Exposing to the right" can 

easily capture an image that, 

for all its wonderful highlight 

detail, is unusable because of 

the problems in the shadows. 

Once on your computer 

screen, the blacks may well 

be indistinguishable from the 

darkest midtones. You might 

try boosting the shadow 

contrast with Curves or Levels, 

or Photoshop's Shadow/ 

Highlights adjustment, but 

there would always be a danger 

of posterization problems. Even 

if you work in 16-bit mode, you 

could end up doing all sorts of 

laborious masking and other 

work to rescue shadow detail. 

REGROUPING 

Another post processing 

workaround is to make two 

differing conversions of the RAW 

file, and sandwich them together. 

Alternatively, Adobe Camera 

Raw and other RAW converters 

now have sliders for "fill light" 

which can detect shadow areas 

and lift their brightness and 

contrast. So instead of 

sandwiching two conversions. 

more can be achieved in the 

RAW converter itself at a single 

pass. But you are still working 

with limited image data about 

the shadows. 

Above: This frame was "exposed to the 

right." Its highlight detail is great, but the 

standing stones are in deepest shadow. 

�:� 
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Left: It is often not an option 

to lift the brightness of 

shadows in an image that 

was underexposed to protect 

highlights-the digital noise 

can be horrendous. 

Left: A second frame 

is exposed to record 

shadow detail. This 

received an additional 

three stops. 

---- - ---- ----



BRACKETING 

While black and white often lets you get 

away with blocked shadows, a great 

solution is to blend bracketed 

exposures. With the camera on a tripod, 

meter as usual and shoot a pair of shots 

of the scene, changing only the 

exposure between frames. One frame 

is "exposed to the right," with the 

highlights fully captured and the 

shadows left to look after themselves. 

The other is usually exposed according 

to the camera meter, blowing out the 

highlights. The two can easily be 

matched up in Photoshop by holding 

down the Shift key as one image is 

dragged onto the other (or using the 

Photomerge tool). The final image 

contains the highlight elements from 

one, and the shadows from the other. 

The dynamic range is at least as great 

as film, and nor does it challenge too 

many scruples about manipulation. 

I@ D Sharpening 

Darken 

Black & White 

Shadow contrast 

Overexposed 

Left: The key to the finished 

image is in the bottom two 

layers. The sky was masked 

out of the overexposed frame, 

allowing the correctly 

exposed sky to show through. 

Below: Sandwiching 

exposures increases your 

camera's dynamic range, and 

provides the viewer with 

interesting detail throughout 

the frame. 
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COLORED FILTERS: NOT FORGOTTEN 

We are only a decade or so into the digital era, and one misconception is that colored 

lens filters might still be useful to shoot black and white with a digital camera. This is a 

mistake. For one thing, we've already seen that you have a lot more creative choice if 

you convert the color image to black and white on computer. Even if you shoot in RAW 

format, a filter will give you an image with a strong color cast that is very likely to restrict 

what you can do at the black-and-white conversion stage, and will certainly prevent you 

from making straight color prints from the same frame. And if you are shooting JPEG

only, then there's no chance at all of making a color version since the camera will only 

save the black-and-white image. Even if you never actually make color prints, why throw 

away the versatility that color capture provides? 

LENS FILTERS: COLOR CASTS 

Newcomers to black-and-white 

photography are often surprised to learn 

how integral colored lens filters have 

been to the art. Made of optical glass or 

resin, the filter allows light of the same 

color to pass through the lens, while 

interrupting other colors. This principle 

gives the film photographer lots of 

control. For instance, a red filter blocks 

green and blue, and so it might be your 

choice if you wanted to darken how a 

blue sky appears in black and white. 

Alternatively you might screw a green 

filter onto the lens if your intention was 

to brighten foliage and make more 

tones apparent in a landscape. 

Experienced black-and-white film 

photographers would typically carry 

a selection of various filters-reds, 

oranges, yellow, blues, and so on-and 

entire books have been written on the 

subject. 
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Left: A huge variety of 

colored filters is available 

for contrast control with 

black-and-white film. 

Left: An orange filter 

would darken skies 

and make clouds 

stand out on black

and-white film, but 

in the digital age it 

removes color, leaving 

this much information 

to work with. 

Right: A color image 

can be easily 

converted to appear 

as if shot on black 

and white with an 

orange filter. 



FILTERS: RAW ALTERNATIVES 

Another reason why colored filters are 

not suitable for digital photography 

relates to how digital cameras capture 

images. The sensor consists of a grid of 

light-sensitive cells. These are usually 

laid out in patterns of four, two of which 

record green brightness values, and one 

each for red and blue. In the camera if 

you are shooting JPEG, or later on 

computer for RAW files, this capture 

data is "demosaiced" to a grid where 

each cell or pixel has red, green, and 

blue values. Broadly speaking, a colored 

lens filter would block light from some 

of the light-sensitive cells, so a red or 

blue filter would mean that only three

quarters of the cells were being used, 

while a green filter would cut that to 

half. This is often enough to degrade the 

image quality and at worst can cause 

bitty artifacts in smooth-toned areas. 

But most of all, it is simply not 

necessary for digital. The underlying 

principles of light filtration are 

unchanged and still relevant. It's just 

that they apply not when the light enters 

the lens, as with black-and-white film, 

but later when you convert the picture 

to black and white and manipulate the 

red, green, and blue channel values. If 

you are shooting JPEG-only, this occurs 

as the camera processes the capture 

data and creates the JPEG, but if you 

are shooting in RAW format, the 

conversion step occurs later in the 

digital darkroom. Colored lens filters are 

no longer needed for shooting black and 

white with a digital camera, but if you 

can find a copy of Ansel Adams's classic 

The Negative, take a look at the use of 

colored lens filters-the underlying 

artistic principles remain relevant and 

translate directly into the language of 

the digital darkroom. 

Above: Digital sensors consist of a grid 

of photocells, each sensitive to one 

color channel. 

Above: In Photoshop, make the pictures 

black and white and zoom right in. The 

orange-filtered image is much noisier than 

the raw color version. 

II�I @ Edge burning 

II!: II Black & White 

II!:I @ iii Black & White 

Background � 

Above: Shooting in RAW and in color 

allows much more creative flexibility. For 

the final image, two channel filtrations 

were used to make the picture black and 

white, like using yellow and red lens filters 

for different parts of the frame. 
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FILTERS FOR DIGITAL BLACK AND WHITE 

A filter is optical-quality material, usually glass or plastic, which is placed over the lens and 

affects how light reaches the film or sensor. Glass filters tend to be more expensive and 

screw directly onto the lens, meaning their thread or diameter has to match. Resin or 

plastic filters slot into standard-size holders which are then attached to the lens using 

adapters for each thread size, so this is much more flexible if you have a few lenses. Some 

lenses, like ultra wide-angles, only take gelatin filters which slide into slots at the rear of 

the lens. There is a wide variety of filters to choose from. 

As we've seen on pages 30-31, 

colored lens filters belong to the 

film era, so that's a whole lot fewer 

lens filters to weigh down your 

camera bag. But what filters remain 

valuable for the digital black-and

white shooter? 

FILTERS: GRADUATED 

"Neutral grads" are filters that are 

graduated from gray to clear. The gray 

half darkens that part of the subject by 

1-3 stops without altering its colors. 

This is useful when the sky is bright in 

relation to the landscape and it lets you 

render detail in all areas without over

exposing or "washing out" the sky. It 

is perhaps worth having a neutral 

graduated filter just in case, but if you 

are using a tripod, it may be as easy to 

bracket a couple of shots and match 

them up later in Photoshop. 
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FILTERS: NEUTRAL DENSITY 

Neutral density filters simply cut 

down all light entering the lens, 

"neutral" signifying that they 

affect all wavelengths uniformly. 

Since less light is reaching the 

sensor, you need to keep the 

shutter open longer to achieve a 

correct exposure, so their biggest 

use is a creative one. They allow 

you to use a much slower shutter 

speed than you would otherwise. 

While the neutral density filter 

remains useful, there's a limit to 

the amount you can carry and the 

polarizing filter can be a fine 

substitute in many circumstances. 

It is effectively a 2-2.5-stop neutral 

density filter. To use it, set the 

lowest ISO value, stop the lens 

down to 122, and attach the filter

this can often be enough to produce 

motion blurring or water and other 

moving objects. 

Below: Use a neutral density filter and 

a small aperture to blur water-this 

exposure lasted 2 seconds at 122. 



FILTERS: POLARIZING 

There's little dispute that, for film or 

digital, polarizers are by far the most 

useful filters and it's worth spending 

a little more for good quality. 

The polarizing filter is actually a 

pair of filters that prevent unpolarized 

light from passing through the lens. 

Reflected light is un polarized, so the 

filter means the camera captures fewer 

reflections off surfaces such as water, 

glass, polished wood, and leaves. As a 

result, these objects' colors are richer 

and more saturated. Sunlight also 

reflects off particles like mist and haze, 

so the polarizing filter makes skies 

bluer and makes clouds stand out. 

The strength of polarization changes 

as you rotate the filter's top layer. It is 

Above: The polarizing filter 

remains as useful in digital 

as it is in film photography. 

Right: The polarizing filter 

captures richer colors and 

usually makes it easier to 

render more detail in the 

black-and-white image. 

also affected by the type of light and by 

its direction, being strongest when the 

filter is at 90 degrees to the sun. 

Sometimes the color saturation effect is 

overpowering, or the filter can cut out 

attractive reflections, so you need to 

decide for each shot whether it should 

be used and to what degree. 

The loss of reflections can be 

particularly important for black and 

white. Without them, colors may be 

more saturated but that doesn't 

necessarily improve the picture's 

appearance and isn't relevant for mono. 

There's always a danger that a polarized 

image will appear dull and lifeless. 

Polarization can make the sky look 

uneven and the make parts of it too 

dark. This is something to watch out for, 

especially with wide angle lenses. 

Also remember that because the 

polarizing filter reduces the light 

reaching the sensor, your exposure 

needs to be longer. While the camera's 

metering system will handle this for 

you, generally you lose 2-2.5 stops and 

for some shots this will mean you may 

have to use a tripod. It is effectively a 

neutral density filter too. 

But these are disadvantages are 

minor by comparison with the polarizing 

filter's huge value. Many photographers 

gladly carry one polarizer for each lens 

thread size. 

TIP 

Always watch out for dark corners 

when you shoot with a filter. This may 

indicate that the filter is vignetting the 

image and is unsuitable for the lens. 

Left: The polarizing filter eliminates 

reflected light. Clouds stand out more 

in blue skies, and here different shades 

have been brought out in the sea. 

---------------------------------------�-----
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DIGITAL INFRARED CAPTURE 

Infrared photography has long been an interesting creative niche In the black-and-white 

medium. It should not be confused with night vision or thermal imaging, where heat 

emissions are captured. Instead, the infrared photographer usually works in daylight and 

uses a lens filter to eliminate the visible wavelengths of light, so the sensor only records 

light from the infrared part of the spectrum. One of the great things about it is that after 

the warm early morning light has disappeared, you can switch to shooting infrared and 

make the most of sun that is directly overhead. 

Another important distinction is 

that here we are talking about 

capturing infrared light directly with 

a digital camera, not simulating the 

effect in Photoshop. A simulation, 

like the one demonstrated on 

pages 128-131, starts with a 

visible-light picture and makes it 

look like it is infrared-turning the 

sky near-black, brightening foliage, 

and so on. Infrared photography, on 

the other hand, captures light that 

we cannot see, and so it often 

records things that would not have 

been in a regular photograph of the 

same scene. For instance, infrared 

light isn't reflected off water in the 

atmosphere, so mist is simply not 

recorded in the infrared capture, 

which consequently reveals cloud 

patterns and distant objects that 

would not have been in the visible

light photograph. 

Shooting infrared with film 

meant loading and unloading the 

rolls in complete darkness, often 

with your hands inside a changing 

bag. By contrast, digital infrared is 

so easy you can shoot one frame 

conventionally and the next in 

infrared. There are essentially two 

choices: having your digital SLR 

modified so it captures infrared, or 

seeing if you can use your existing 

camera with an infrared lens filter. 

The first approach permits shutter 

speeds high enough to hand-hold 

the camera, but it's costly and 

means dedicating the camera body 

to infrared. The second approach 
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usually means much longer 

exposure times and forces you 

to use a tripod. This isn't a bad 

thing-it opens up fascinating 

creative opportunities to blur 

moving objects like clouds and 

produce a distinctive digital infrared 

style very different from film-based 

infrared photography. Whichever 

approach you take, it's faster and 

much more satisfying to achieve 

the infrared look in-camera than 

to fake it in Photoshop. 

Below: Infrared captures are fundamentally 

different from visible-light photographs. 

Here the infrared exposure was so long it 

blurred the water and the boats. It also 

shows the power station over the estuary 

that wasn't in the visible-light picture 

(below left) shot at the same time. 



INFRARED: DIGITAL CAPTURE 

Digital cameras are not all equally 
good at capturing infrared light. 

Infrared (lR) degrades the quality of the 
regular image, so camera makers have 
good reasons to add anti-IR filters to the 
digital sensor. Their effectiveness varies, 
not just between camera makes but 
between models. For example, Nikon 
used to have less effective IR filters 
than Canon, and so were generally 
better for infrared photography, but 
more recent models have been 
trumpeted as having reduced IR 
sensitivity. One person's feature is 
another's disappointment. 

While your camera manual may 
specify your camera's infrared capability, 
it's easy to work it out for yourself. Set 
your camera's exposure mode to 
Manual and use the Bulb shutter speed 
so you can hold the shutter open for a 
few seconds. Then, in darkness, release 
the shutter and fire an infrared remote 
control-like the one for your TV-into 
the lens. Check the LCD and see if the 
sensor has captured an image. 

ft Once you know your camera can 
... capture infrared, you need an 
infrared filter over the lens. These are 
made of glass or gel and block light 
from the visible spectrum so that only 
infrared wavelengths reach the sensor. 
Many brands are available, and they vary 
in strength and the wavelength above 
which they begin to permit light. 
Infrared light's wavelength is over 700 

nanometers, and the higher this value, 
the purer the infrared capture and the 
less visible light will be recorded. 

This infrared filter fits into a filter 
holder while others are available which 
screw directly onto the lens. 

B 
The infrared filter usually gives 
photographs a weird red or purple 

color. You can eliminate this in 
Photoshop or you may save post
processing time by setting your camera 
to shoot black and white. 

If your camera has no black-and
white mode, try setting a custom white 
balance. How you do so varies, so 
check your camera manual, but usually 
it's a case of shooting a mid-gray subject 
through the filter. Once you've set up 
the preset, the camera will capture a 
black-and-white picture, though a slight 
color cast often remains. 

Left: The infrared image 

will often show a red or 

purple color cast before 

image processing. 
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D A 

INFRARED: DIGITAL CAPTURE CONTINUED 

a Unless your camera body has , 
been converted for infrared, IR 

photography usually means using a 

tripod. This is because most digital 

cameras need such long exposure times 

for infrared, often m�ny seconds, and 
you can't hold the camera still for that 

long. Equally important is the fact that 
the infrared filter is so opaque that you 
can't see to compose the picture, even 
if your camera has an electronic 
viewfinder. So mount the camera on a 

tripod, frame the shot and focus, and 

then attach the lens filter. 

ft It's also a good idea to stop down 
U the aperture. This is because 
infrared light focuses at a slightly 

different point to visible light and a 

smaller aperture's greater depth of field 

will counteract this difference. A second 
aspect is that there are good creative 
reasons for setting a slower shutter 

speed and having greater depth of field. 
At f16 or f22, digital infrared exposures 
may last 30 seconds or longer, so you 
can blur water and moving objects and 
this creates a digital infrared effect very 
distinct from film infrared. Here the 
exposure was a minute, giving the 
clouds time to move across the sky. 
Notice too how well a Lith effect works 
with infrared. 

... If you use an SLR, there is a 
U danger that visible light can reach 
the sensor through the eyepiece, and 

this can easily overwhelm the infrared 

light. Some cameras have a switch to 
close the viewfinder, or add an eyepiece 
cover. You won't have this problem if 
your camera doesn't have an optical 

viewfinder and you use the LCD to 

compose the picture. 
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D Digital infrared exposure is slightly 

tricky but it's easy to follow a 
"plan-do-review" cycle. For your first 
infrared captures, use the camera's 

automatic setting to determine the 
exposure, and then review the captures 
carefully on the LCD-the histogram 
can quickly tell you how much you need 

to adjust the exposure. You will probably 

need to make a few tests before you 
can decide how it responds to infrared. 



Most of the work is done by the 

time you press the shutter. If you 

have set a custom white balance, you 

may just need to desaturate the image 

in Photoshop and remove any remaining. 

color casts. Also hot pixels may be 

visible because of the long exposure, 

but these can be fixed easily with 

Photoshop's Spot Healing Brush tool or 

by using Adobe Camera Raw 4's spot 

healing feature. 

Here, Adobe Camera Raw picked 

up my custom white balance but this 

infrared capture still has a slight color 

cast. I can drag the Saturation slider to 

-100% and quickly make it pure black 

and white. 

Digital infrared is so easy you can 

take one conventional image, adjust 

the exposure, add the filter, and 

shoot the next frame in infrared. 

You can then stack the two images 

in Photoshop and apply the Color 

blending mode to the color image. 

It's a technique I like to call the 

"infrared sandwich." 

Below: Classic infrared subjects include various 

shades of foliage, and interesting skies with 

broken clouds. Notice that the digital infrared 

picture doesn't have the glow or graininess 

typical of infrared film photography. 
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DESTRUCTIVE TECHNIQUES 
Photoshop's black and white functionality has" history." Every year or two, a new version 

of the program provides tools that make better techniques possible or practical. Layers of 

tutorials accumulate over time. An outdated method might be recycled in a new-looking 

web site, or a convincing commentator in an online forum might not mention he uses an 

old version, or may even be so stuck in an earlier era that he sees no need for today's best 

practice. You can spend forever working out what belongs in which era of development, 

what's old and best forgotten, and what's the best way for you to work. 

In the following pages we are 

going to try to make sense of 

this accumulated knowledge 

and examine some of the many 

techniques for rendering a color 

image as black and white. The 

older ways still produce quality 

results and won't be ignored, but 

they also have disadvantages in 

GRAYSCALE 

There are some very simple ways to 

make an image black and white, and 

none is simpler than Image> Mode> 

Grayscale. This changes all pixel values 

in the file to grayscale values. 

Photoshop examines each pixel and 

takes 59% of its Green channel value, 

30% of its Red and 11 % of the Blue, so 

a dark bluish pixel which has an RGB 

value of 35:35:82 will becomes 58. This 

ratio comes from an assessment of the 

average color responsiveness of the 

human eye, so the results are pretty 

average too. 

It is quick, and the resulting file will 

take up less disk space since all the 

color information is discarded. On the 

other hand, once you save and close the 

file, the image's color values are gone 

forever, so you can never adjust the 

black-and-white conversion. In other 

words, this method isn't very flexible 

and gives you no creative control over 

the black-and-white conversion. 

terms of flexibility and creative 

expression. We will then examine 

how more modern methods exploit 

the information in the image's color 
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channels, using adjustment layer 

and masks, so the final image is 

the best black-and-white treatment 

you can achieve. 

Left: Italian protest 

rallies often seem 

motivated more bV 

fun than politics. 



DESATURATE 

Another easy method is to use Image> 
Adjustments> Oesaturate or Ctrl/O+ 
Shift+U, which simply discards the 
image's saturation value. You can 
produce the same results by adding 
a Hue/Saturation adjustment layer and 
dragging the Saturation slider all the 
way to the left. 

Like the Grayscale method, it's a 
"one size fits all" approach, but it also 
ignores how the eye responds to colors. 
Again, the absence of creative input 
means this is one to avoid. 

GRADIENT MAP 

The Gradient Map method maps 
a monochrome gradient to the 
image's luminosity values. First reset 
Photos hop's colors (0) and then add 
a Gradient Map adjustment layer. 
Adjusting the Smoothness slider 
controls how the gradient relates to 
image luminosity, while other sliders 
change the gradient's brightness 
range. In effect, the Gradient Map 
method lets the user adjust image 
contrast while also making the image 
black and white, and perhaps that is 
behind its cult status on the forums 
that is otherwise hard to explain. 
While you can get decent results, 
you're also ignoring the color channels 
and losing their creative potential. 
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Above: The destructive methods can all 

produce good results but their "one size 

fits all" approach means there is no scope 

for creativity. They are best avoided. 
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DESTRUCTIVE TECHNIQUES 

MATCH COLOR 

Although this tool is really designed 

for matching colors, like skin tones, 

acrosss a number of images, it can 

be repurposed for an unusual 

destructive monchrome conversion. 

There are two ways the tool can be 

taken advantage of, depending on 

the outcome you're looknig for. The 

simplest, for example, is to use it 

only in reference to the image you're 

Image Options 

luminance [iDOl 
0 

Cotor Intensity Irl 
£l 
Fade IOl 
0 
C Neuualize 

Select Image> Adjustment > 
Match Color. A dialog will 

appear with two distinct sections, 

Image Options at the top and Image 

Statistics at the bottom. To use the 

existing color from the image, simply 

slide the Color Intensity slider to the 

lowest possible value and click OK. 

ImageStatistlcs----------, 
Use Selection in Source to Calculate Colors 

source:I===!i;�= 
laver: ��:::=.;==� 

(load Statistics ... 

(Save Statistics ... 

Alternatively, if you're interested 

in using the color from another 

image, then before you click OK 

choose it from the Source drop-down. 

It's also possible to save your favorite 

statistics 

working on, and dial down the color 

intensity. That might sound idental to 

desaturation, but instead of removing all 

the color a duotone-like effect is 

created, using the image's predominant 

color to create the tone. The result is 

dependant on the image you start with, 

but it can be quite pleasing. 

The second way of worknig with 

Match Color, at least for our purposes, 
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is to take advantage of its ability to 

work from other source images. If, 

for example, you've found an image 

with color tones that you like, then 

simply select it and perform the same 

reduction of the Color Intensity setting. 

This trick can be applied to more than 

one image, giving them matching 

duotone-style conversions. 

Left: The original image, which has 

a high concentration of red. 

Left: The resulting image from the simple 

Color Intensity reduction method. 

Left: An alternative treatment, using 

the color tones from the lake image. 

Left: The lake image has 

a more subtle blue/green 

feel, but that still has an 

effect if converted using 

the one-step method. 



LIGHTNESS 

The Lightness method involves 

switching the image's color mode 

from RGB to Lab, which records the 

brightness and the color values 

separately. The color information is 

then thrown away, leaving just black 

and white. Like the other basic 

methods, Lightness is a destructive 

technique, changing pixel values 

permanently. The color information 

remains in the History palette, but is 

lost when you close the file. If you want 

to fine-tune the conversion, you have 

to go back to your original photograph. 

Lightness also applies to the file as a 

whole, and offers no opportunities to 

use the individual color channel values 

to control how individual tones and 

areas are converted. 

Select Image> Mode> 

Lab Color. 

COLOR BLEND 

Another quick conversion technique 

involves adding a Color Fill adjustment 

layer and selecting a shade of white 

through to black. Then change the 

layer's blending mode to Color. This 

means its only effect is to render the 

image black and white. It doesn't 

have any real virtue and I include it 

only for completeness. 

IColor 

Lab Ctrl+(., 

lightness 

a 

b 

[ v ]Opacity:llOO% (£] 

Background � 

EJ Activate the Channels palette, 

delete either the a or the b 

channel, and you're done. Alternatively, 

select the Lightness channel and then 

choose Image> Mode> Grayscale, 

Right: But of the 

basic methods, 

Lightness is 

probably the best. 

The resulting black

and-white picture 

is usually the most 

natural or neutral 

rendition of the 

original scene's 

brightness. If that 

is what you want, 

don't rule out the 

Lightness method. 
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CALCULATIONS 

Under Photoshop's Image menu lurks the mysterious Calculations command. Its main 

role is in retouching and compositing, where it is used to make sophisticated selection 

masks, so Calculations is not something most photographers would ever need to use. 

Nonetheless Calculations can merge the values from up to two color channels and output 

a new, black-and-white Photoshop document. 

Because you can control the mixing 

of color channel values, Calculations 

permits more creative control than 

other basic methods over how 

tones are rendered in black and 

white. Historically, it also made the 

most of limited computing power 

and disk space, and predates 

Photoshop layers. 

Such limitations are now behind 

us, and Calculations is neither as 

convenient nor versatile as modern 

Above: When you are experimenting with 

mono conversion techniques, select 

images with a variety of colors, such as 

the strong greens and reds in this rallv 

layer-based techniques. The new 

black-and-white document the 

command creates contains no color 

information, so changing your mind 

about the color-to-mono rendition 

means starting all over again. Since 

such fine-tuning is so much easier 

now using other techniques, it isn't 

immediately appealing. Calculations 

can produce great results, but its 

awkwardness can limit your 

creative experimentation. 
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So why is it covered here? 

First, Calculations is still touted 

often enough that it needs to be 

put in its historical context. The 

second reason is more important, 

and that is to introduce the role of 

channels and creative black-and

white conversion. 

Left: Although it can 

be awkward to use, 

Calculations does 

offer a degree 

creative control. 

Using the blue 

channel darkens the 

skin tones on this 

man's face, so the 

photographer can 

convey that he is a 

heavily tanned man. 

It also tones down 

the background and 

changes the 

emphasis of the 

composition. 



CALCULATIONS METHOD 

Source l� 06103o_04261 pension pro ... I.,1 

Sour(e
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2: I061030 _04261PenSion pro 'hl"l � 
Layer L�round ! ... I 
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Gray 
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; ===5� 

Opacity � . 
o MaSk ... 

Rnult:!NewDo<:ument 

o Pr"itw 

a Choose Image> Calculations and 

go directly to the Result section at 

the bottom of the dialog box. You need 

to set this to New Document, because 

while Calculations may be previewed 

in the working image, it can only make 

selections of channels there. Also, the 

Layer drop-down boxes should in general 

be set to Merged, so any retouching 

layers are included in the process. Use 

the Background Layer if there are no 

other layers. 

The most important controls are 

two Channel drop-down boxes which 

enable you to choose the channels that 

Calculations merges into its black-and

white output document. For instance, 

pick Red in one drop-down box, and 

Calculations' output will show lighter 

skin tones, because the red channel 

values of skin are quite high. Choose 

Blue, and for the same reason 

Calculations' mono output will render 

skin tones darker. To bring out more 

tones in green, such as in the striped 

flag here, you'd pick Green in one or 

both Channel drop-down boxes. 

Source 1:1 061030_04261 pension pro 

Layer: ! eackground 

Source 2: I 061030_04261 pension pro 

Result: I New Document 

c::::QLJ 
� 
0Preview 

EJ Experiment with the Blending drop

down box and its accompanying 

Opacity box, where you can vary the ratio 

of each channel's value that goes into the 

output document. 

When the preview shows a mono 

image that you like, click OK, and 

Photos hop sends the combined mono 

image to a brand new document. You're 

no longer just switching off the color

you're manipulating and controlling how 

it is rendered in black and white. Once 

you start using the channel values, 

mono conversion starts to become a 

creative process. 

Left: Calculations lets you control how 

Photoshop blends the color channel values 

into a new black-and-white document. 

Here, Red channel values lighten and 

soften the subject's face, but they also 

make the mostly red background so blown 

out that it distracts from the subject. 
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THE TOOLS OF THE TRADE 

We have discussed many of the older methods of converting a color image to black and 

white. These techniques can do the job, and often well, but they all date from earlier eras 

in the history of Photoshop black and white, and limit your creative choices while being 

difficult to control. Worse still, color channel data is lost so you can't come back and fine

tune your work at a later date. 

Today's best conversion 

techniques let you creatively 

exploit the image's color 

channel information and 

fine-tune the mono conversion. 

You can make the conversion 

separate the colors, so greens 

and reds might be distinguished 

by differing shades of gray. In 

Calculations, we saw one 

example of how channel 

manipulation could vary the 

background's brightness relative 

to the picture's subject. Modern 

methods give you an enormous 

degree of control over the tonal 

balance and scope for choosing 

how the composition should 

work in black and white. And 

they all use adjustment layers, 

so you can revisit, improve, 

or completely reverse the 

conversion any time you want. 

INDIVIDUAL CHANNELS 

On the following pages we are going to 
examine the main techniques that are 
applicable today. But whichever method 
you prefer, the first step is to assess 
the color image. 

Even if you only do black-and-white 
work occasionally, it is worth changing 
Photoshop's Preferences so the color 
channels are displayed as grayscale. Go 
to Edit> Preferences> Interface and 
uncheck the option to Show Channels 
in Color. This switches off the red, 
green, or blue overlay that makes it 
difficult to assess the information that 
is in each channel. 
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When I start a black-and-white 
conversion, I almost always begin by 
cycling quickly through the channels. 
In the Channels palette, you can click 
each channel's eye icon in turn, but the 
keyboard shortcuts always seem easier. 

First press Ctrl/O+ 1 to see the red 
channel, Ctr1/0+2 for the green, 
Ctrl/0+3 for the blue, and Ctrl/O+ -
(tilde) to return to a normal RGB image. 
This is a very quick operation-you may 
want to repeat it a couple of times
and has two main purposes. 

At a basic level, it tells you the 
characteristics of the three channels 

a Red: Ctrl/O+l 



which make up the color image. Each 
image is different. Looking at the 
examples below, the Blue channel 
picture shows the man's face is very 
dark in that channel, while the 
background and his vest are very bright. 
That would be their appearance in the 
final black-and-white image if you 
stressed the Blue channel in your 
conversion. During this process you are 
looking at specific details within the 
photograph. Pressing Ctr1/0+2 for 
Green makes the vest look dark, making 
the lettering stand out, and tones down 
the background, while Ctr1/0+1 for Red 
produces the brightest facial detail. 

Green: Ctrl/0+2 

My initial diagnosis of this picture 
is that the Green channel produces the 
best overall conversion, but the face 
works better with the Red channel, so 
I need a second adjustment layer. In 
other words, before you add an 
adjustment layer to make the image 
black and white, the Ctrl/O+ 1-3 cycle 
tells you which sliders you may want to 
adjust, and whether you might need to 
make some selective mono conversions 
with extra adjustment layers. 

The second reason for this cycle is 
far less tangible. Seeing the three 
channels' individual black-and-white 
representations is a really quick way to 

.. 

see three alternative interpretations of 
the photograph. There are times when 
this completely changes how you 
initially intended to compose your black
and-white image. I don't pretend looping 
through the channels is a magic bullet, 
but try it and see if your results improve. 

Blue: Ctr1/0+3 



THE CHANNEL MIXER 

The Channel Mixer method has long been a popular way of converting an image to black 

and white and gives you creative control over the proportions of each channel's value in 

the mono image. Since the technique uses adjustment layers, you can always return to 

the file and change the settings, and layer masks let you apply local conversions too. 

One disadvantage is that. if you are not careful, Channel Mixer can clip the highlights 

and shadow tones, but on the other hand it functions in a way that is very natural for 

photographers with experience of colored lens filters and black-and-white film. If that 

includes you, it can be a big plus. 

USING THE CHANNEL MIXER 

Above: It's early one winter morning, the 
sky is a rich blue, and the fortress, Castel 
SantAngelo in Rome, is resplendent in 
warm colors. A black-and-white film 
enthusiast would probably have used 
an orange or red filter for this scene. 

a Evaluate the color image by cycling 
through the channels with Ctrl/O + 

1, 2, 3 and -. Think in terms of details or 
subjects, and compositional regions like 
the top or the edges. In this image, the 
key areas are the fortress, which is the 
main subject, and the cloud pattern. 
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Left: The Red channel (Ctrl/O + 1). The top 

of the picture is dark, the clouds are weI/
defined against the sky, and the fortress is 
very bright. 

Below Left: The Green channel (Ctrl/O +2). 
Similar to the Red channel, though the sky 
is slightly less dark. The fortress is much 
less bright. 

Below: The Blue channel (Ctrl/0+3) This 
version is obviously unacceptable-the sky 
is far too pale, which makes the clouds 
pale, and also lets the viewer's eye drift up 
and away from the picture's subject. Black
and-white film shooters would never have 
used a blue filter for this scene. 



A variation on the Channel Mixer technique 

is to split the channels and reassemble 

them as pixel layers. Go to the Channels 

palette, and select Split Channels from 

the palette menu. This produces three 

grayscale documents. Shift and drag 

each of the new images back into one 

document, and use masks or vary the 

layer opacities. Also include a layer 

Channel Mixer 1 

Background 

Once you have assessed the 

image, and hopefully gained an 

idea of how you want to render it, add a 

Channel Mixer adjustment layer and tick 

the Monochrome checkbox. Photos hop 

previews the resulting image in black 

and white, though initially with a rather 

uninteresting mix of channel values. 

There is also a Channel Mixer 

command in the Image> Adjustments 
menu, but this changes pixel values 

directly so you can't revise your work 

after you close the file. For versatility, 

always use adjustment layers-notice 

from the Layers palette how the color 

information is preserved, so you can 

always revise the mono conversion. 

Right: The Channel Mixer is a 

technique that comes naturally 

to black-and-white film 

photographers. To darken the 

sky, use more Red filtration. 

created by converting a duplicate using the 

Lightness method. Adjustment layers are 

more convenient, and in principle there are 

no differences in final output quality. 

Output Channel: I Gray [v I 
Source Channels ------------, 

Red: �96 
�----------r_----�� 
Green: �96 �----------�o�-------

Blue: 

Total: +140 96 

Constant: 
�--------�Or----------

� Monochrome 

II Drag the three Channel Mixer 

sliders and review how they 

affect the black-and-white output. In 

general. try to keep the contrast at 

100%, but concentrate less on overall 

image contrast-which can be fixed 

later-and more on key details and the 

overall compositional balance of the 

image. Here the Red is high, darkening 

the sky. Increasing it further would burn 

out detail in the fortress, so the Green 

value was increased instead, and Blue 

reduced to keep the overall brightness 

in balance. 
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"FILM AND FILTER" 
The "film and filter" method is also known as "twin hue and saturation" because it relies 

on a pair of Hue/Saturation adjustment layers. Made popular by Adobe's Russell Brown, 

you add one Hue/Saturation adjustment layer that represents how black-and-white film 

records the scene in monochrome, and another that filters the overall image color. 

Film and Filter is less intuitive 

for film enthusiasts than the 

Channel Mixer, and produces an 

image that is lower in contrast, 

so it is more likely that you will 

need another adjustment layer 

to fine-tune brightness and 

contrast. This isn't a problem, 

though, because it mentally 

separates overall contrast issues 

from the more creative thought 

processes required to make the 

various grayscale blocks work 

well together in the black-and

white composition. The example 

on these pages shows how that 

happens in practice. 

USING THE "FILM AND FILTER" METHOD 

Edit: I Master \vi CQL] 
Hue � � 

0 
� Saturation: � 

Q � 

lightness: [LJ 
0 

DColorlze 

/.,t.,t o Preview 

a Add a Hue/Saturation adjustment 

layer and drag the Saturation slider 

all the way to the left. Since this layer's 

purpose is simply to make the image 

grayscale, name it "Film." 
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1�:Olor - . .•• A3 OpacitvjlOO% (I] 

Lock: 0 d + a FilljlOO% [] 

fii Il�1 Film 

fii 
I b:�11 

Filter 

EJ Activate the Background layer 

and add a second Hue/Saturation 

adjustment layer, which should be 

below Film in the layer stack. Like the 

film user's colored lens filters, this 

layer's purpose is to control the colors 

that the Film layer will capture. Name 

the new layer" Filter" and change its 

blending mode to Color. 

EJ Double-click the Filter layer's 

Hue/Saturation icon and adjust 

the Hue slider until the image looks 

right. You can also alter the Saturation 

and Lightness sliders if you wish. 

Left: The final mono print 

needs to be realistic but 

that's not necessarily the 

same as being faithful to 

the original. In the black

and-white conversion, 

you are able to control how 

you interpret the scene. 



Edit:! Master j..,I-------, 
Hue � 

� 
Saturation: EI 

�----(o)----
Lightness: � 

�----(Ol----

� 
� 

DColorize 
)I ,,(.1 E] Preview 

Left: This Hue setting makes this image 

a black-and-white photograph of a weI/

tanned man. Notice how his skin tones 

are darker than the sky. It's realistic and 

believable. 

r Edit: I Master [vi C2LJ 
"" � � 

0 
� Saturation: � 

0- � 
Lightness: � 

0 

/.(.( 
DColorfze 
E]Preview 

Left: With aI/ channel-based conversion 

techniques, you interpret the scene for the 

viewer. In this version, simply by changing 

the Hue, the eye is drawn to the man 

because his skin is much lighter and is 

set against a darkened sky. 



C53 BLACK AND WHITE 

Photoshop CS3 introduced a new tool for the mono enthusiast; the Black and White 

adjustment. It shares all the main characteristics of other modern techniques, with creative 

channel-based control via six color-specific sliders and availability as an adjustment layer, 

and it also integrates toning or tint in the same dialog box. 

But what really marks CS3 Black 

and White apart-and the reason 

it is used throughout this book-is 

its "targeted adjustment tool." 

This makes the cursor into a sort 

of brush which you use to stroke 

the image and control your mono 

conversion interactively. Even 

better if your use a tablet and pen, 

it's as though you are painting your 

black-and-white rendition. 
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Above: Just after 

nightfall, there is 

not enough color 

in the sky. 

Left: The final 

version has a lot 

more punch; the 

sky is near black 

and there is plenty 

of highlight detail. 



USING A BLACK AND WHITE ADJUSTMENT LAYER 

Above: A simple gravscale 
conversion is too bland. 

Black & White 1 

Background @ 

a Add a new Black and White 

adjustment layer, and Photoshop 

applies a default conversion and 

displays a preview. To lighten how an 

individual color is rendered in grayscale, 

drag the corresponding slider to the 

right. Dragging it left has the opposite 

effect. So, in this example, moving the 

Yellow and Red sliders to the right 

would brighten up the arches. 

II The true glory of Black and White 

is the targeted adjustment tool. 

Sliders are all well and good, but the 

image preview is in monochrome and 

you can very quickly forget what the 

picture looked like in color. 

So, instead of dragging sliders, 

move the cursor over a part of the 

picture that you would like to brighten, 

such as the arches in this night photo. 

Hold down the mouse button and drag 

to the right in a painting-like motion. 

Preset IRedFJlter 

F.�� 
CQLJ 

Reds: � 
8 � 

Yellows: @D� 0Preview 
g 

Greens: -ED'"' 
g 

(yans: -0'"' 
g 

Blues: -[0'" 
g 

Magentas: -�'" 
g 

DIint 

"" Do 
Saturation D% 0 

D Black and White is all about 

controlling the conversion process 

interactively, so I'm not so fond of the 

Auto button, but notice the Preset drop

down box which contains a selection of 

slider value combinations. They are 

equivalent to colored lens filters and 

even if you've got no black-and-white 

film experience, Presets is often a great 

starting point. 

Photoshop detects the colors in that 

area and makes the grayscale rendition 

lighter, moving the dialog box's sliders 

for you. 

To darken an image area, like the 

sky here, drag the cursor across that 

area in a leftward motion. Use a number 

of short strokes to build up the effect 

gradually, or use a single longer action. 

It'll soon start to feel like a very natural, 

creative process. 

- -- ._---- - ------+--
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